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ΠΕΡΙΛΗΨΗ 

 

Η εργασία αυτή αποτελεί τμήμα μιας ολοκληρωμένης προσπάθειας με σκοπό την 
ενοποίηση των γεωλογικών σχηματισμών ανά γεωτεκτονική ενότητα του Ελλαδικού 
χώρου και αφορά τις ενότητες Παξών, Ιόνιας, Γαβρόβου-Τριπόλεως, Μάνης και Άρνας. 
Η ενοποίηση των γεωλογικών σχηματισμών βασίστηκε στους γεωλογικούς χάρτες του 
ΙΓΜΕ, που υφίστανται σε αναλογική μορφή, οι οποίοι στην συνέχεια ψηφιοποιήθηκαν με 
την βοήθεια του Συστήματος Γεωγραφικών Πληροφοριών ArcGis. Λόγω της 
ανομοιογένειας κατά την κατασκευή τους, τόσο σε διαφορετικές χρονικές περιόδους, όσο 
και από διαφορετικούς ερευνητές κρίθηκε επιτακτική η ανάγκη επαναεπεξεργασίας τους 
για την δημιουργία ενός ενιαίου ψηφιακού γεωλογικού χάρτη. Με τη χρήση του 
Συστήματος Γεωγραφικών Πληροφοριών, διακρίθηκαν οι γεωτεκτονικές ενότητες με τους 
σχηματισμούς τους, και στη συνέχεια ομαδοποιήθηκαν, κωδικοποιήθηκαν και 
αποτυπώθηκαν χρωματικά με την χρήση της Ευρωπαϊκής Γεωβάσης Inspire για την 
ηλικία, και την παλέτα συμβόλων της Αμερικάνικης Γεωλογικής Εταιρίας (USGS) για τη 
λιθολογία, δημιουργώντας έτσι μια εμπλουτισμένη βάση δεδομένων, η οποία είναι 
δυνατόν να δεχθεί και περαιτέρω επεξεργασία. Τέλος, δημιουργήθηκε μία νέα παλέτα 
συμβόλων για κάθε γεωλογικό σχηματισμό, έτσι ώστε να μπορεί να χρησιμοποιηθεί 
αυτούσια από τους ερευνητές – μελετητές. 
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ABSTRACT 

This work is part of an integrated effort to unify the geological formations according to the 
geotechnical unities of Greece and concerns the units of Paxoi, Ionian, Tripoli-Gabrovo, 
Arna and Mani. The integration of geological formations was based on geological maps 
of IGME, which exist in analog form, which were subsequently digitized with the help of 
the ArcGis Geographical Information System. Because of the heterogeneity in their 
construction, both at different times and by different researchers, it was considered 
imperative to reprocess them to create a single digital geological map. With the use of 
the Geographic Information System, geotechnical units were identified with their 
formations, then grouped, encoded and color-coded using the European Geospatial 
Inspire for Geological Age, and the United States Geological Survey (USGS) symbol 
palette for lithology, thus creating an enriched database that can be further processed. 
Finally, a new palette of symbols was created for each geological formation, so that it 
could be used in the same way by researchers - scholars. 
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ΠΡΟΛΟΓΟΣ 

Η γεωλογία είναι η επιστήμη που μελετά την Γη, και κυρίως το στερεό της τμήμα. Τα 
ορυκτά, τα πετρώματα από τα οποία αποτελείται η γη, οι τεκτονικές δομές που 
δημιουργούνται από την παραμόρφωση των πετρωμάτων, τα απολιθώματα που 
χρησιμοποιούμε για τη χρονολόγηση των στρωμάτων, τα κοιτάσματα και οι υπόλοιποι 
ορυκτοί και φυσικοί πόροι.   

Στη σύγχρονη εποχή, η γεωλογία απέκτησε και μεγάλο οικονομικό ενδιαφέρον, γιατί 
διευκολύνει και συστηματοποιεί την έρευνα για σημαντικά ορυκτά και ιδιαίτερα για τα 
φυσικά αποθέματα υδρογονανθράκων, άνθρακα, μεταλλευμάτων αλλά και νερού. Είναι 
ακόμη πολύ σημαντική για την κατανόηση και την προσπάθεια πρόβλεψης αρκετών 
ειδών φυσικών καταστροφών. Επίσης, προσφέρει καλύτερη αξιολόγηση των 
περιβαλλοντολογικών προβλημάτων, καθώς μπορεί να «δει» τις κλιματικές αλλαγές που 
έγιναν στο παρελθόν. 

Η βασικότερη γεωλογική εργασία στην ύπαιθρο, είναι η γεωλογική χαρτογράφηση και η 
κατασκευή του γεωλογικού χάρτη μιας περιοχής. Ένας τέτοιος χάρτης είναι απαραίτητος 
σε όλους τους κλάδους και τις εξειδικευμένες εφαρμογές της γεωλογίας 

Ο γεωλογικός χάρτης, πέρα από τις βασικές πληροφορίες που μας δίνει για τους 
σχηματισμούς, τα ρήγματα, επωθήσεις - εφφιπεύσεις κλπ, χρειάζεται και κάποια 
απαραίτητα στοιχεία για την ορθή απεικόνιση του, και στην συνέχεια την κατανόηση του 
από τον αναγνώστη. Τέτοια στοιχεία είναι η κλίμακα χαρτογράφησης, η λεπτομερής 
απεικόνιση των γεωλογικών σχηματισμών ως προς την θέση, τα όρια τους και τις 
πληροφορίες που πρέπει να περιέχει ένας γεωλογικός χάρτης. 

Τα τελευταία χρόνια, καθώς η επιστήμη εξελίσσεται, υπάρχουν ολοένα και περισσότερα 
τεχνολογικά μέσα, που δίνουν την δυνατότητα, η απεικόνιση αυτή να γίνεται σε ψηφιακή 
μορφή. Αρχικά, οι πρώτες χρήσεις της τεχνολογίας βασίστηκαν στην απεικόνιση ενός 
χάρτη μέσω του ηλεκτρονικού υπολογιστή, ενώ προηγουμένως είχε προηγηθεί μελέτη 
στην ύπαιθρο και καταγραφή βασικών στοιχείων. Αργότερα, η χαρτογράφηση μιας 
περιοχής, γινόταν και με την βοήθεια κάποιων χρήσιμων ειδικών συσκευών π.χ. PDA, τα 
οποία μας παρείχαν πληροφορίες, όπως για παράδειγμα, τις συντεταγμένες του σημείου 
που βρισκόμαστε με τη βοήθεια δορυφορικού στίγματος. Σήμερα, η καταγραφή 
δεδομένων, πραγματοποιείται πλέον επιτόπου στο πεδίο, ακόμα και με την χρήση των 
κινητών τηλεφώνων. Οι συσκευές κινητής τηλεφωνίας διαθέτουν ενσωματωμένο GPS, 
για την λήψη στίγματος, με αναφορά των συντεταγμένων της θέσης μας, όπου με ειδικές 
εφαρμογές γίνεται η μετατροπή τους στο επιθυμητό προβολικό σύστημα. Η αποτύπωση 
των δεδομένων της περιοχής γίνεται μέσω ειδικών αντίστοιχων εφαρμογών. Το 
μεγαλύτερο πλεονέκτημα της ψηφιακής απεικόνισης ενός χάρτη είναι ότι μας παρέχεται 
η δυνατότητα να επέμβουμε ανά πάσα στιγμή και να πραγματοποιήσουμε οποιαδήποτε 
αλλαγή χωρίς το κόστος της επανεκτύπωσης ή επαναδημιουργίας του χάρτη εκ του 
μηδενός. 

Η εργασία αυτή αποτελεί μια τέτοια προσπάθεια ψηφιακής απεικόνισης των γεωλογικών 
χαρτών του Ελλαδικού χώρου, επιλύοντας ταυτόχρονα προβλήματα που υπήρχαν στους 
εκτυπωμένους χάρτες του ΙΓΜΕ. Η αποτύπωση ενός σχηματισμού με την χρήση 
διαφορετικών χρωμάτων και συμβολισμών στα γειτονικά φύλλα ενός χάρτη, όπου αυτός 
συνεχιζόταν σε αυτούς εκατέρωθεν, καθιστούσε δύσκολη την ανάγνωση των 
πληροφοριών μιας περιοχής. Λόγω της ανομοιογένειας κατά την κατασκευή τους, τόσο 
σε διαφορετικές χρονικές περιόδους, όσο και από διαφορετικούς ερευνητές κρίθηκε 
επιτακτική η ανάγκη επαναεπεξεργασίας τους, για την δημιουργία ενός ενιαίου ψηφιακού 
γεωλογικού χάρτη. 



Βασικός παράγοντας της δημιουργίας του χάρτη, είναι η ομαδοποίηση των σχηματισμών 
σε γεωτεκτονικές ενότητες, όπως αυτές διακρίνονται από τους γεωεπιστήμονες στον 
Ελλαδικό χώρο. Στην συνέχεια έγινε απλοποίηση, ομαδοποίηση και κωδικοποίηση των 
«πακέτων» των σχηματισμών κάθε μίας ενότητας, ως προς την ηλικία τους και τα 
γεωλογικά χαρακτηριστικά της εκάστοτε γεωλογικής περιόδου. Η διαδικασία αυτή 
πραγματοποιήθηκε έπειτα από βιβλιογραφική έρευνα. 

Τέλος, με τη χρήση του Συστήματος Γεωγραφικών Πληροφοριών ArcGIS, οι σχηματισμοί, 
αποτυπώθηκαν χρωματικά με την χρήση της Ευρωπαϊκής Γεωβάσης Inspire για την 
ηλικία, και την παλέτα συμβόλων της Αμερικάνικης Γεωλογικής Εταιρίας (USGS) για τη 
λιθολογία, δημιουργώντας έτσι μια εμπλουτισμένη βάση δεδομένων, η οποία είναι 
δυνατόν να δεχθεί και περαιτέρω επεξεργασία στο μέλλον.  
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1. ΕΙΣΑΓΩΓΗ 

1.1 Εισαγωγή στην Γεωλογία 

1.1.1  Παλαιογεωγραφία-Γεωλογική Ιστορία 

 Ο Ελλαδικός χώρος χαρακτηρίζεται από πλούσια γεωλογική ιστορία. Μια ιστορία που 
ξεκινάει από τον Παλαιοζωικό αιώνα και συνεχίζει μέχρι σήμερα. Η χώρα μας, έχει 
επηρεαστεί από τον Αλπικό ορογενετικό κύκλο και τα πετρώματα όπου έλαβαν μέρος με την 
πτύχωσή τους, σχημάτισαν τις Ελληνίδες οροσειρές. Τα πετρώματα αυτά, έχουν 
διαμορφωθεί κατά την διάρκεια του Αλπικού ιζηματοορογενετικού κύκλου και έχουν 
διαρθρωθεί σε διάφορες Γεωτεκτονικές Ζώνες, δηλαδή γεωλογικές ενότητες, που κάθε μια 
από αυτές έχει τους δικούς της λιθολογικούς, παλαιογεωγραφικούς και τεκτονικούς 
χαρακτήρες. 

1.1.2  Οργάνωση και εξέλιξη Αλπικού ορογενετικού κύκλου 

Ο Αλπικός ορογενετικός κύκλος διήρκησε από τις αρχές του Μεσοζωικού (κάτω Τριαδικό) 
μέχρι και ένα μέρος του Καινοζωικού, ενώ στον Ελλαδικό χώρο ακόμα εξελίσσεται. Η 
ορογένεση εντοπίζεται στις ζώνες σύγκλισης των λιθοσφαιρικών πλακών, όπου η 
λιθόσφαιρα συμπιεζόμενη πλευρικά, είναι αναγκασμένη να κινηθεί είτε προς τα κάτω, είτε 
προς τα πάνω. Στην πλειοψηφία, οι ζώνες σύγκλισης επηρεάζουν τα παθητικά περιθώρια 
των ηπείρων, που τα μετατρέπουν σε ενεργά, με τις τεκτονικές επαφές των δυο πλακών να 
απαντούν υποθαλάσσια. Έτσι δημιουργούνται ορογενετικές αλυσίδες, που εμφανίζονται 
συχνά με την μορφή νησιών-νησιωτικό τόξο. Οι Ελληνίδες οροσειρές, όπως και οι 
υπόλοιπες αλπικές οροσειρές της Ευρασίας και της Αφρικής, είναι αποτέλεσμα του 
«κλεισίματος» του ωκεανού της Τηθύος.  

 

Εικόνα 1.1: Σχηματική απεικόνιση ενός ορογενετικού τόξου ως αποτέλεσμα της Σύγκλισης πλακών – 

φαινόμενο υποβύθισης πλάκας (Παπανικολάου, «Γεωλογία της Ελλάδας», 2015) 
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1.1.3  Ο ωκεανός της Τηθύος 

Ο ωκεανός της Τηθύος ήταν ένας περίπλοκος ωκεανός, με βαθιές αύλακες και ρηχά 
υβώματα (Γ.Χ. Κατσικάτσος), ή ένας ωκεανός που εκτός από τις βαθιές περιοχές με ωκεάνιο 
φλοιό, είχε και πιο ρηχές περιοχές με νηριτική ιζηματογένεση με ηπειρωτικό φλοιό (Δ. Ι. 
Παπανικολάου). Λόγω αυτής της ιδιαιτερότητας της Τηθύος, συναντάμε σημαντικές 
διαφοροποιήσεις στα πετρώματα που αποτελούν τις οροσειρές του αλπικού κύκλου, που, 
όμως κατά ομάδες εντάσσονται σε συγκεκριμένες κατηγορίες, τις Γεωτεκτονικές ζώνες. Κατά 
τον Μεσοζωικό αιώνα, ο ωκεανός αυτός, εκτεινόταν ανάμεσα στην Ευρασία και στην παλαιά 
ήπειρο της Γκοντβάνας, η οποία σήμερα αντιπροσωπεύεται από την Ινδία, την Αφρική και 
την Αραβική χερσόνησο.   

1.1.4 Γεωτεκτονικές ζώνες 

Η διάκριση των τεκτονοστρωματογραφικων πεδίων και των γεωτεκτονικών ενοτήτων μέσα 
σε καθένα από αυτά, αποτελεί τη βασική γνώση της αλπικής δομής της Ελλάδας. Οι 
γεωτεκτονικές ζώνες, που δομούν τις Ελληνίδες οροσειρές στην ηπειρωτική Ελλάδα, έχουν 
διεύθυνση ΒΒΔ –ΝΝΑ και περιέχονται μεταξύ της Απούλιας τράπεζας, προς τα δυτικά, και 
των κρυσταλλοσχιστωδών μαζών της Σερβομακεδονικής και της Ροδόπης, προς τα 
ανατολικά, που αποτελούσαν, αντίστοιχα, τμήματα του αφρικανικού και του ευρασιατικού 
ηπειρωτικού περιθωρίου. 
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1.2 Περιγραφή γεωτεκτονικών ενοτήτων 

Οι γεωτεκτονικές ζώνες διακρίθηκαν από τον J. Brunn (1956) σε Εξωτερικές και Εσωτερικές, 
με βάση τα παρακάτω κριτήρια:  

Οι Εξωτερικές γεωτεκτονικές ζώνες, χαρακτηρίζονται από συνεχή ιζηματογένεση, κατά το 
Τριαδικό μέχρι και το μεγαλύτερο τμήμα του Τριτογενούς και σε μερικές περιπτώσεις μέχρι 
και το Κατώτερο – Μέσο Μειόκαινο. Αντίθετα, οι Εσωτερικές γεωτεκτονικές ζώνες, έχουν 
προσβληθεί από δύο κύριες ορογενετικές φάσεις: μια στο τέλος του Ανώτερου Ιουρασικού 
– Κατώτερου Κρητιδικού και μια δεύτερη κατά το Τριτογενές. Επιπλέον, οι Εσωτερικές 
ζώνες, χαρακτηρίζονται από την παρουσία οφιολιθικών πετρωμάτων σ’ αυτές, και σε πολλές 
περιπτώσεις, από συνορογενετική μεταμόρφωση των σχηματισμών τους. Τέλος, ένα ακόμη 
κύριο χαρακτηριστικό τους, είναι ότι οι μέσο – ανωκρητιδικοί σχηματισμοί τους, είναι 
επικλυσιγενείς. 

Εκτός από τις παραπάνω δύο ομάδες ζωνών, διακρίθηκε και μια τρίτη ομάδα, που 
περιλαμβάνει χαρακτηριστικά, τόσο των Εξωτερικών ζωνών, όσο και των Εσωτερικών (J. 
Fleury 1980, F. Thiebault 1982, J. Ferriere 1982). Ακριβέστερα στην ομάδα αυτή, που 
ονομάστηκε ομάδα των Ενδιάμεσων γεωτεκτονικών ζωνών, περιλήφθηκαν όλες οι πιο 
εσωτερικές από τις Εξωτερικές ζώνες, όπως: η Βοιωτική, του Παρνασσού και η ζώνη της 
Πίνδου, καθώς επίσης οι Ενότητες του Νεοελληνικού τεκτονικού καλύμματος, οι οποίες, 
εκτός από τον τεκτονισμό των Εξωτερικών ζωνών, έχουν δεχθεί και τον απόηχο του 
τεκτονισμού των Εσωτερικών ζωνών. 

Η περιοχή όπου ασχολήθηκα εκτείνεται από τα βόρεια σύνορα της Ελλάδας, στην Αλβανία 
μέχρι και την Νότια Πελοπόννησο και γεωγραφικά ακολουθεί παράλληλα την οροσειρά της 
Πίνδου, από την δυτικά της. Γεωλογικά είναι οι Εξωτερικές Γεωτεκτονικές ζώνες και 
συγκεκριμένα αυτές των Παξών, Ιόνιας, Μάνης, Άρνας και Γαβρόβου-Τρίπολης και τις 
εμφανίσεις τους στην Δυτική και Κεντρική Ελλάδα. Δηλαδή τις εμφανίσεις τους στον 
Ηπειρωτικό χώρο της Ελλάδας, στα νησιά Ιονίου και στα Κύθηρα. 

 

Εικόνα 1.2: Γεωτεκτονικός χάρτης Δυτικής και Ελλάδας, σημειώσεις Γεωλογία Ελλάδος, ΕΚΠΑ 
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1.2.1 Ενότητα Παξών 

Πρόκειται για την εξωτερικότερη ενότητα όλων των Ελληνίδων, η οποία προέρχεται από το 
δυτικό περιθώριο της εξωτερικής τους πλατφόρμας. Θεωρείται ότι η ενότητα συνεχιζόταν 
δυτικά με τον σημερινό ωκεανό της ανατολικής Μεσογείου στο ιόνιο πέλαγος Η0, πριν 
αρχίσει η πρόσφατη υποβύθιση του κάτω από τους Παξούς και την υπόλοιπη εξωτερική  
πλατφόρμα. Εμφανίζεται καθ’ ολοκληρία στους Παξούς, Λευκάδα, Κεφαλλονιά και Ζάκυνθο. 

Σύμφωνα με τον J.Aubouin(1959), ο οποίος την ονόμασε Προαπούλια, αποτελεί το 
εσωτερικό ανατολικό περιθώριο της Απουλίας ζώνης. Δεν πρόκειται για καθαρό ύβωμα , 
αλλά και για κλιτύς δεδομένου ότι έχει πολλούς ορίζοντες από μικρολατυποπαγείς 
ασβεστολίθους. Αντίθετα, καθαρή πλατφόρμα γίνεται με τη μορφή υποθαλάσσιας τράπεζας 
στην περιοχή της Απουλίας, στην νότια Ιταλία. Γενικότερα, το μεγαλύτερο τμήμα της ζώνης 
των Παξών, βρίσκεται κάτω από την θάλασσα του Ιονίου πελάγους. Κάτω από την θάλασσα 
αυτή, βρίσκεται και το πέρασμα ανάμεσα στην ζώνη των Παξών και την Απούλια ζώνη, το 
οποίο θεωρείται πως γίνεται κανονικά, χωρίς στοιχεία ύπαρξης κάποιας μεγάλης τεκτονικής 
επαφής. 

Ανατολικά, η Ιόνια Ενότητα επωθείται στην Ενότητα των Παξών. Δυτικά και βόρεια του 
ρήγματος της Κεφαλλονιάς, η ενότητα των Παξών επωθείται στην Απουλία. Νότια του 
ρήγματος, η δομή είναι πιο πολύπλοκη. Η ενότητα των Παξών, συνιστά τη μεταβατική 
ενότητα από την Ιόνια αύλακα στο ύβωμα της Απουλίας. Κύριο όμως χαρακτηριστικό της, 
είναι η απουσία τυπικού φλύσχη, τον οποία αντικαθιστά μία σειρά από μαργαϊκούς 
ορίζοντες, οι οποίοι εναλλάσσονται με λατυποπαγείς ασβεστολίθους. 

Η ζώνη των Παξών, χαρακτηρίζεται από μια συνεχή σειρά νηριτικών ανθρακικών 
πετρωμάτων, που αρχίζει από το Άνω Τριαδικό και φθάνει μέχρι και το Ολιγόκαινο. 

 

  

Εικόνα 1.3: Σχηματική στρωματογραφική στήλη Ενότητας Παξών, φύλλο χάρτη Λευκάδας 

(Μπορνόβας, 1964) 
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Σε γενικές γραμμές η στρωματογραφική διάρθρωση είναι:  
1. Εβαπορίτες, δολομίτες και νηριτικοί ασβεστόλιθοι, με πάχος περίπου τα 1500μ  

2. Νηριτικοί ασβεστόλιθοι και δολομίτες του Άνω Ιουρασικού με Clypeina sp., στους 
οποίους παρεμβάλλονται διαστρώσεις πυριτικών σχιστολίθων και μαργών. Το πάχος 
τους φθάνει τα 500μ περίπου. 

3. Η παραπάνω ανθρακική ιζηματογένεση συνεχίζεται σε ολόκληρο το Κρητιδικό μέχρι 
και το Παλαιογενές, με απόθεση νηριτικών ασβεστολίθων συνολικού πάχους 1500μ 
περίπου(Κεφαλλονιά), που συχνά είναι μικρολατυποπαγείς. Αναλυτικότερα, το Άνω 
Κρητιδικό αντιπροσωπεύεται από νηριτικούς και υφαλογόνους ασβεστολίθους με 
Ιππουρίτες. Στο Μαιστρίχτιο περιλαμβάνεται ένας χαρακτηριστικός ασβεστολιθικός 
ορίζοντας με Orbitoides, ενώ στο Ηώκαινο και στο Ολιγόκαινο, νηριτικοί ασβεστόλιθοι 
που έχουν χαρακτηριστικά όμοια με τους ασβεστολίθους της Απούλιας ζώνης και 
εναλλάσσονται με μικρολατυποπαγείς ασβεστολίθους. Όλοι αυτοί οι ασβεστόλιθοι, 
είναι πολλές φορές ψαμμούχοι εναλλασσόμενοι με λατυποπαγείς ασβεστολίθους, 
που υποκαθιστούν την τυπική φλυσχική ιζηματογένεση των άλλων γεωτεκτονικών 
ενοτήτων. 

 

 

 

  

Εικόνα 1.4: Στρωματογραφική απεικόνιση Ενότητας Παξών, με βάση την κωδικοποίηση 
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1.2.2 Ιόνια Ενότητα 

Η Ιόνια ζώνη αποτελεί την αμέσως πιο εσωτερική ενότητα, μετά εκείνη των Παξών, των 
Εξωτερικών Ελληνίδων. Αρχίζει από την Αλβανία και εκτείνεται προς τα νότια στην Δυτική 
Ηπειρωτική Ελλάδα(Ήπειρος και Ακαρνανία), τα Ιόνια νησιά, Δυτική Στερεά και την 
Βορειοδυτική Πελοπόννησο. Οι εμφανίσεις της ενότητας συνεχίζουν υποθαλάσσια στο Ιόνιο 
Πέλαγος. 

Δυτικά, επωθείται στην Ενότητα των Παξών, ενώ ανατολικά στην Ήπειρο επωθείται και 
επωθεί την ενότητα της Πίνδου. Νοτιότερα, επωθείται από την ενότητα Γαβρόβου και 
μοιράζονται τη φλυσχομόλλασα Ηπείρου‐Ακαρνανίας. 

Με βάση τον Aubuin, αποτελούσε υποθαλάσσια αύλακα (sillon), που παρεμβαλλόταν 
ανάμεσα στα υποθαλάσσια υβώματα της Απουλίας στα δυτικά και του Γαβρόβου‐Τρίπολης 
στα ανατολικά (Aubouin, 1959). 

 Η στρωματογραφία της ενότητας, είναι στενά συνδεδεμένη με την εξέλιξή της, από 
ανθρακική πλατφόρμα σε λεκάνη πελαγικής ιζηματογένεσης στο Μέσο Λιάσιο. Λόγω των 
διαφορών που παρουσιάζει στη στρωματογραφική της στήλη, στην αξονική περιοχή της με 
τις παρυφές της, διακρίνεται σε Εξωτερική, Κεντρική και Ανατολική Ιόνια Ενότητα 

Η στρωματογραφική στήλη της ενότητας λόγω της αλλαγής των συνθηκών ιζηματογένεσης, 
διακρίνεται σε προ‐ταφροσιγενή, συν‐ταφροσιγενή και μετα‐ταφροσιγενή πετρώματα. Η 
διαφοροποίηση ήταν αποτέλεσμα ενός εφελκυστικού επεισοδίου που πιθανά συνδέεται με 
το άνοιγμα του ωκεανού της Τηθύος. Η διαφορική βύθιση επιμέρους υπολεκανών της 
αύλακας, σε συνδυασμό με φαινόμενα αλατοκίνησης των εβαποριτών στη βάση της 
ενότητας, οδήγησαν σε σημαντικές πλευρικές μεταβολές στη φάση των ιζημάτων και στο 
πάχος των σχηματισμών. 

 

-Προ‐ταφροσιγενείς σχηματισμοί: 

❖ Ασβεστόλιθοι Παντοκράτορα (600μ.) λεπτοκοκκώδεις σε παχιά στρώματα, 
συμπαγείς με ασβεστοφύκη, Κατώτερο‐Μέσο Λιάσιο. 

❖ Ασβεστόλιθοι Φουσταπήδημα (150μ.), με Cardita, Λαδίνιο‐Ραίτιο 

❖ Εβαπορίτες – Τριαδικά λατυποπαγή, γύψοι με μικροκρυσταλλική υφή,αναμειγμένα 
με λατυποπαγή. 

 

Ιζηματολογικές μελέτες, έχουν δείξει ότι τα τριαδικά λατυποπαγή είναι αποτέλεσμα της 
διάλυσης – κατάρρευσης των υπεδαφικών εβαποριτών. Η διαδικασία αυτή προσέλαβε τις 
διαπειρικές διεισδύσεις της εβαποριτικής βάσης κατά τη διάρκεια της παραμόρφωσης της 
ενότητας, ενώ η δημιουργία της αρχικής λεκάνης ιζηματογένεσης ήταν αποτέλεσμα 
διαφορικής καταβύθισης και απομόνωσης, από την Τηθύ, περιοχών της δυτικής Μεσογείου 
κατά το Κατώτερο Τριαδικό (Bosellini & Hsu, 1973). H εβαποριτική λεκάνη φαίνεται να 
περιορίζεται εντός των ορίων της Ιόνιας ζώνης.  

Οι ασβεστόλιθοι Φουσταπήδημα σηματοδοτούν το τέλος της εβαποριτικής ιζηματογένεσης 
και την αρχή της αμιγούς θαλάσσιας ιζηματογένεσης. Ο Παντοκράτορας αντιστοιχεί σε πολύ 
ρηχή πλατφόρμα στο όριο της ανάδυσης. Το πάχος του  δείχνει ταχεία βύθιση της 
πλατφόρμας και αντιστάθμιση της βύθισης με γρήγορη ιζηματογένεση. 
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-Συν‐ταφροσιγενείς σχηματισμοί: 

❖ Ανώτεροι Σχιστόλιθοι με Posidonia (50μ.) Πλούσιοι σε πυρίτιο και ακτινόζωα. Ηλικία 
Οξφόρδιο‐Τιθώνιο. (Ραδιολαρίτες).  

❖ Πελαγικοί ασβεστόλιθοι με filaments (Βαγιώσιο – Καλλόβιο). 

❖ Ammontitico Rosso και Κατώτεροι Σχιστόλιθοι με Posidonia (Τοάρσιο‐Ααλένιο). 

❖ Ασβεστόλιθοι Σινιών – υπολιθογραφικοί ασβεστόλιθοι με ακτινόζωα και 
ενδιαστρώσεις πυριτιολίθων και ασβεστόλιθοι Λούρου μικριτικοί ασβεστόλιθοι με 
βραχιονόποδα και αμμωνίτες). Πλιενσβάχια ηλικία. 

Οι φάσεις Σινιών και Λούρου σηματοδοτούν τη γενική βάθυνση της λεκάνης. Η φάση Σινιών 
απαντά στην αξονική περιοχή της λεκάνης, ενώ του Λούρου στις κρασπεδικές περιοχές της.  
Η κατανομή των υπερκείμενων σχηματισμών δείχνει ότι η απόθεσή τους έλαβε χώρα σε 
λεκάνες μορφής ημιτάφρων. Προχωρώντας από το βαθύτερο προς το ρηχότερο τμήμα της 
λεκάνης, παρατηρείται μετάβαση από την πλήρη ακολουθία των σχηματισμών προς μη 
πλήρεις ακολουθίες με ελάττωση του πάχους ή και απουσία σχηματισμών με hiatus. Σε 
ορισμένες θέσεις παρατηρείται ασύμφωνη απόθεση του “Σχηματισμού της Βίγλας” πάνω 
στον “Παντοκράτορα”. 

-Μετα‐ταφροσιγενείς σχηματισμοί: 

❖ Ασβεστόλιθοι (300μ.) λεπτοπλακώδεις με Globigerines και μικρολατυποπαγείς 
ορίζοντες με Nummulites, Alveolines και μερικές ενστρώσεις πυριτόλιθων, 
Παλαιόκαινο‐Ηώκαινο 

❖ Ασβεστόλιθοι Σενωνίου (<300μ.) μικρολατυποπαγείς συμπαγείς με θραύσματα 
Ρουδιστών, Orbitoides. 

❖ Σχιστόλιθοι Βίγλας (<150μ.) Εναλλαγές μαργών, ασβεστολίθων, αργιλικών 
σχιστολίθων, Κενομάνιο‐Τουρώνιο. 

❖ Πλακώδεις Ασβεστόλιθοι Βίγλας (300μ.) με ακτινόζωα και ενστρώσεις πυριτιολίθων. 
Στην βάση υπάρχουν άφθονες Calpionelles, ενώ στο ανώτερο τμήμα επικρατούν 
διάφορα είδη Globotruncana. Βερριάσιο – Κατώτερο Σενώνιο. 

Η απόθεση των ασβεστολίθων της Βίγλας σηματοδοτεί την ομογενοποίηση των συνθηκών 
ιζηματογένεσης. Παρά τη γενική βύθιση της Ιόνιας λεκάνης, η ανθρακική ιζηματογένεση 
οφείλεται σε πτώση της στάθμης CCD, η οποία στο όριο Ιουρασικού‐Κρητιδικού ήταν πολύ 
σημαντική. Η απόθεση των σχιστολίθων Βίγλας σηματοδοτεί την άνοδο της στάθμης της 
θάλασσας. Από το Κατώτερο Σενώνιο και μετά λατυποπαγείς ασβεστόλιθοι σε παχιούς 
πάγκους που φανερώνει μία πιο ρηχή ιζηματογένεση με μεταφορά προϊόντων διάβρωσης 
από τις όμορες πλατφόρμες.  

 

-Φλύσχης: 

Φλύσχης (>2,000μ.) εναλλαγές ψαμμιτών, πηλιτών, κροκαλοπαγών με λιθοκλάστες 
ανθρακικής, πυριτικής και σπανιότερα υπερβασικής σύστασης, Αν. Ηώκαινο-Ολιγόκαινο. 
Από ανατολικά προς τα δυτικά παρατηρείται αύξηση στην αναλογία λεπτόκοκκων 
σχηματισμών έναντι χονδρόκοκκων. Τα μεγαλύτερα πάχη του φλύσχη απαντούν στο 
σύγκλινο Ηπείρου -Ακαρνανίας (6.000m) δίπλα από το μέτωπο της επώθησης της Πίνδου. 
Η προοδευτική ανάδυσή της από ανατολικά προς τα δυτικά από το Κατώτερο Μειόκαινο 
έως το όριο Πλειο‐πλειστοκαίνου, οδήγησε στην απόθεση μολασσικού τύπου ιζημάτων. 

 
 



Ψηφιοποίηση και ενοποίηση γεωλογικών σχηματισμών ενοτήτων Παξών, Ιόνιας, Γαβρόβου-Τριπόλεως, Μάνης και Άρνας 

Ευθυμία Καλαματιανού-Δημητροπούλου   21 

Από τεκτονικής άποψης, η ενότητα χαρακτηρίζεται από τρία κύρια επεισόδια 
παραμόρφωσης με τη δημιουργία πτυχών, εφιππεύσεων και ρήγματα οριζόντιας 
ολίσθησης: 

i. Φάση του Ακουιτανίου –Βουρδιγαλίου, που σημαδεύτηκε από την ασυμφωνία του 
Βουρδιγαλίου. 

ii. Φάση στο τέλος του Βουρδιγαλίου, κύρια τεκτονική φάση που έδωσε τις κύριες δομές 
και συνοδεύτηκε από έντονη διάβρωση. 

iii. Φάση του Μειο‐πλειοκαίνου έως σήμερα. 

 

 

Εικόνα 1.5: Στρωματογραφική απεικόνιση Ιόνιας Ενότητας, με βάση την κωδικοποίηση 
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1.2.3 Ενότητα Μάνης 

Οι κυριότερες εμφανίσεις της ενότητας είναι στον Ταΰγετο και Πάρνωνα, όπου συνιστούν 
τον υψηλό πυρήνα αυτών των οροσειρών. Η ενότητα αυτή χαρακτηρίζεται και ως Ενότητα 
των Plattenkalk, δηλαδή των πλακώδων ασβεστολίθων ή μαρμάρων.  

Η ενότητα της Μάνης, θεωρείται πως είναι η μεταμορφωμένη Ιόνια Ενότητα, για αυτό και 
συχνά συγκρίνεται με αυτή, με βασική διαφορά την απουσία των εβαποριτών. Γενικά η 
μεταμόρφωσή της έχει γίνει σε χαμηλές συνθήκες. Συσχετίζοντας τους διαφόρους ορίζοντες 
της σειράς των Plattenkalk με τους αντίστοιχους της μη μεταμορφωμένης σειράς της Ιόνιας, 
η κολώνα της ενότητας διαμορφώνεται ως εξής: 

❖ 300μ περίπου, μοσχοβιτικοί, χλωριτικοί και χαλαζιακοί σχιστόλιθοι, στην περιοχή του 
Ταϋγέτου 

❖ 600μ περίπου, κρυσταλλικοί δολομίτες, δολομιτικοί ασβεστόλιθοι, 
παχυστρωματώδεις με μικρολατυποπαγείς παρεμβολές στα ανώτερα μέλη τους, ενώ 
στην κορυφή αυτών βρέθηκαν μικρά Megalodontidae. Ο ορίζοντας αυτός 
συσχετίζεται με τους δολομίτες και τους Ασβεστολίθους Παντοκράτορα της Ιόνιας. 

❖ 20-100μ κρυσταλλικοί ασβεστόλιθοι με μαύρους πυριτολίθους, ομόλογοι των 
ασβεστολίθων Σινίων 

❖ 30-50μ κρυσταλλικοί ασβεστόλιθοι με Filaments, που εναλλάσσονται με στρώματα 
χαλαζιτών και συσχετίζονται με τους Ενδιάμεσους ασβεστολίθους με Filaments της 
Ιόνιας. 

❖ 20-100μ λεπτά πυριτικά στρώματα(Χαλαζίτες), ομόλογα των σχιστολίθων με 
Posidonies της Ιόνιας ζώνης στην περιοχή Ηπείρου-Ακαρνανίας. 

❖ 100-200μ μάρμαρα με βολβούς και διαστρώσεις πυριτολίθων, που συσχετίζονται με 
τους Ασβεστολίθους Βίγλας  

❖ 200μ μάρμαρα εναλλασσόμενα με στρώματα άσπρων χαλαζιτών. Πολύχρωμα 
σιπολινομάρμαρα, ομόλογοι των πελαγικών ασβεστολίθων Ηωκαίνου Ηπείρου-
Ακαρνανίας 

❖ Και ο Φλύσχης, αποτελούμενος από ανθρακικούς και ψαμμιτικούς πηλίτες. 

 

Τεκτονικά, αποτελεί ότι πιο βαθύ γνωρίζουμε στην Πελοπόννησο και υπόκειται της ενότητας 
Φυλλιτών‐Χαλαζιτών (Άρνας). Σήμερα, σε μία τομή στην Πελοπόννησο, βλέπουμε την 
ενότητα της Τρίπολης κάτω από την ενότητα της Πίνδου και κάτω από την Τρίπολη την 
ενότητα της Μάνης, όπου παρεμβάλλεται ανάμεσά τους η Άρνα, με την μορφή σφήνας. 
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Εικόνα 1.6: Στρωματοτεκτονικές Ενότητες ΝΔ Πελοποννήσου, φύλλου χάρτη «Σπάρτη», ΙΓΜΕ, 1990 

 

Εικόνα 1.7: Στρωματογραφική απεικόνιση Ενότητα Μάνης, με βάση την κωδικοποίηση 
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1.2.4 Ενότητα Άρνας (Φυλλιτών‐Χαλαζιτών) 

 Γενικότερα η ενότητα αυτή εμφανίζεται κυρίως στην Πελοπόννησο, στα Κύθηρα αλλά και 
στην Κρήτη. Αποτελεί την ανώτερη τεκτονική ενότητα της Εξωτερικής Μεταμορφικής Ζώνης 
των Ελληνίδων. Βρίσκεται τεκτονικά υποκείμενη της ενότητας της Τρίπολης και υπερκείμενη 
της Μάνης. Εμφανίζεται ανάμεσα σε αυτές τις δύο ενότητες με την μορφή “σφήνας” και 
θεωρείται ότι έχει υποστεί μεταμόρφωση, σε συνθήκες υψηλών πιέσεων‐χαμηλών 
θερμοκρασιών (HP/LT). Απολιθώματα έχουν βρεθεί μόνο στην Κρήτη.  

Στην νότια Πελοπόννησο, η ενότητα καταλαμβάνει μεγάλες εκτάσεις στον Ταΰγετο, στον 
Πάρνωνα και στις μεταξύ τους χαμηλές τοπογραφικές περιοχές, όπως και στη χερσόνησο 
του Μαλέα. Μικρότερες εμφανίσεις απαντούν δυτικά του Άργους (Μερκούρι) και στη 
Ζαρούχλα, ανάμεσα στη Ζήρια και τον Χελμό. Στις θέσεις αυτές όμως, δεν απαντάται η 
κατώτερη ενότητα της Μάνης. 

 

 Η ενότητα Φ.Χ. στον Ταΰγετο χαρακτηρίζεται από την παρουσία μεταβασαλτών με 
χαρακτήρες MORB, μεταπηλιτών, μετακροκαλοπαγών και σερπεντιωμένων 
χαρτζβουργιτών. Η ενότητα δεν είναι ομοιογενής, αλλά υποδιαιρείται σε τρεις ή τέσσερις 
υπο‐ενότητες που δείχνουν διαφορές στο βαθμό μεταμόρφωσης, αλλά παρουσιάζουν κοινή 
τεκτονική εξέλιξη. Αυτές είναι τοποθετημένες η μία πάνω στην άλλη, με μικρής κλίσης 
τεκτονικές επαφές ανωτέρων τεκτονικών ορόφων, που φανερώνει ότι η σημερινή θέση τους 
είναι μετά‐μεταμορφική. Στον κεντρικό Πάρνωνα και στο Δυτικό Ταύγετο οι υπο‐ενότητες 
είναι σε ανεστραμμένη θέση. Το πάχος της ενότητας Φ.Χ. ποικίλλει και πολλές φορές οι 
ανώτερες ενότητες είναι τοποθετημένες πάνω στην υποκείμενη ενότητα της Μάνης. Ενότητα 
Φ.Χ. 

 

 Η ακολουθία από μεταψαμμίτες, φυλλίτες και πολύ λίγα ανθρακικά με πιο σημαντικά ορυκτά 
αλβίτη, χλωρίτη και χλωριτοειδές. Η ακολουθία από μαρμαρυγιακούς σχιστόλιθους, 
χαλαζίτες και βασικά ηφαιστειακά με λίγα ανθρακικά και ορθογνεύσιους. Οι τουρμαλινίτες 
είναι ένας χρήσιμος δείκτης της ακολουθίας. Τα πιο σημαντικά ορυκτά είναι ο Νa‐πυρόξενος, 
ο γλαυκοφανής και το χλωριτοειδές, απουσιάζει ο γρανάτης. Η ακολουθία από 
γρανατιτικούς, μαρμαρυγιακούς σχιστόλιθους και χαλαζίτες με λίγα ανθρακικά και 
γρανατιτικούς αμφιβολίτες. Η παρουσία του γρανάτη είναι ένα κύριο χαρακτηριστικό 
γνώρισμα αυτής της ακολουθίας. Άλλα σημαντικά ορυκτά είναι επίσης ο γλαυκοφανής και 
το χλωριτοειδές. Μία ακολουθία από μετακροκαλοπαγή και μαρμαρυγιακούς σχιστόλιθους 
με Fe‐Mg καρφολίτη και χλωριτοειδές. Στα Κύθηρα ραδιοχρονολογήσεις σε γρανιτική φλέβα 

εντός της ενότητας έδωσαν ηλικία 300 Ma. Ενότητα Φυλλιτών‐Χαλαζιτών (Άρνας). 
Τουλάχιστον τρεις φάσεις παραμόρφωσης, με ισοκλινείς πτυχές κτλ. Συνθήκες 
μεταμόρφωσης από 7‐10kb και 3430‐430oC για την πρώτη ακολουθία και έως 14‐18kb και 
460‐530οC για την τρίτη ακολουθία. Ηλικία μεταμόρφωσης Κ. Μειόκαινο. Τη μεταμόρφωση 
ακολούθησε ισόθερμη αποσυμπίεση. Γεωχρονολογικά δεδομένα δείχνουν ότι οι Φ.Χ. 
έφτασαν στο βάθος των 10‐15 km και Τ 300–350οC, πριν από 13 Ma στον Ταΰγετο και 16 
Ma στον Πάρνωνα (Jolivet et al. 2010). Ηλικίες με ζιρκόνια FT δείχνουν ότι οι Φ.Χ. έφτασαν 
σε Τ 240 ο C πριν από 12.8–10.1 Ma (Marsellos et al. 2010). Ηλικία που αντιστοιχεί όταν οι 
Φ.Χ. και η Μάνη ήρθαν σε μεταξύ τους επαφή σε P 4–5 kbar (Trotet et al. 2006). Ηλικίες με 
απατίτη FT δείχνουν ότι η επαφή ανάμεσα στην Τρίπολη και τους Φ.Χ. έλαβε χώρα στο 
Ανώτερο Μειόκαινο (6.8–9.8 Ma, Marsellos et al. 2010).  

 

Εικόνα 1.8: Στρωματογραφική απεικόνιση Ενότητας Άρνας, με βάση την κωδικοποίηση 
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1.2.5 Ενότητα Γαβρόβου-Τρίπολης 

 Η ζώνη αυτή καταλαμβάνει το μεγαλύτερο μέρος της Πελοποννήσου και ένα σημαντικό 
τμήμα της Δυτικής Ηπειρωτικής Ελλάδας. Εμφανίζεται επίσης στην Αλβανία και την 
Γιουγκοσλαβία σαν προέκταση της. Προς τα νότια, εμφανίσεις της υπάρχουν τόσο στα 
Κύθηρα, όσο και στην Κρήτη και τα Δωδεκάνησα, ενώ συνεχίζεται και στην Μ. Ασία, βόρεια 
της Αττάλειας. 

 Η ζώνη αυτή έχει αναφερθεί από μερικούς ερευνητές, ως δύο ξεχωριστές ενότητες ή 
υποζώνες: την υποζώνη Γαβρόβου-Πύλου και την υποζώνη της Τρίπολης, διότι Γάβροβο 
και Πύλος είναι ακριβώς το ίδιο και σαν στρωματογραφικές κολώνες, και σαν ηωκαινικές 
βωξιτικές εμφανίσεις(Κλόκοβα, Βαράσοβα, Πύλος) και κυρίως σαν τεκτονική θέση. Και οι 
δυο περιοχές είναι μπροστά από το μέτωπο του καλύμματος της Πίνδου, ενώ η Τρίπολη 
εμφανίζεται πιο πίσω στο τόξο, σε τεκτονικά παράθυρα κάτω από την Πίνδο.  

 Ο χώρος στον οποίο αποτέθηκαν τα ιζήματα της ζώνης Γαβρόβου -Τρίπολης, αποτελούσε 
μια τεράστια υποθαλάσσια τράπεζα-πλατφόρμα ανάμεσα στις δύο θαλάσσιες αύλακες, την 
Ιόνια και την Πινδική, που τότε καταλάμβανε τον χώρο και των δύο υποενοτήτων. Υπάρχουν 
μικρές διαφορές ως προς την στρωματογραφική-παλαιογεωγραφική και τεκτονική εξέλιξη, 
που όμως δεν τις καθιστούν σε καμία περίπτωση ως ανεξάρτητες παλαιογεωγραφικές 
ενότητες. Πιθανόν το Γάβροβο να είναι η ίδια ενότητα με την ενότητα της Τρίπολης, κάτω 
από το κάλυμμα της Πίνδου. Το μεν Γάβροβο, αποτελεί το δυτικό τμήμα μιας μεγάλης 
ανθρακικής πλατφόρμας, με συνεχή ιζηματογένεση από το Άνω Τριαδικό έως το Ανω 
Ηώκαινο. Ενώ η Τρίπολη αποτελεί το κεντρικό και ανατολικό τμήμα της πλατφόρμας.  

 

Η κύρια διαφορά τους, είναι η τεκτονική τους θέση: 

i. Περμο-τριαδική βάση της στρωματογραφικής στήλης  και το τεκτονικό υπόβαθρο της 
ενότητας Γαβρόβου-Πύλου μας είναι άγνωστα δεδομένου ότι δεν εμφανίζονται κάτω 
από τα ανθρακικά του Γαβρόβου, σε αντίθεση με την Τρίπολη 

ii. Στην οροφή του Γαβρόβου υπάρχει ο ολιγοκαινικός-μειοκαινικός φλύσχης, που 
δείχνει να έχει κάποια κοινή εξέλιξη με την Ιόνια μετά το Ανώτερο Ηώκαινο 

iii. Η ενότητα Γαβρόβου-Πύλου έχει πιο ήπιο τεκτονισμό και καθόλου μεταμόρφωση, 
ενώ η Τρίπολη έχει πιο έντονη τεκτονική δομή, με λεπιώσεις λόγω αποκολλήσεων 
και με μεταμόρφωση πολύ χαμηλού βαθμού στα στρώματα της βάσης της.  

 

 Είναι σαφές λοιπόν, ότι μπορεί κάλλιστα ο παλαιογεωγραφικός χώρος Γαβρόβου, Πύλου, 
Τρίπολης να ήταν ενιαίος, αλλά από ένα σημείο και ύστερα έγινε μια διαφοροποίηση κατά 
την ορογενετική περίοδο. Το πρόβλημα του ενιαίου φλύσχη, που καλύπτει τόσο την Ιόνια 
ενότητα δυτικά όσο και το Γάβροβο ανατολικά, έχει σημαντικές επιπτώσεις και στο εάν 
υπάρχει πλευρική μετάβαση μεταξύ Ιόνιας και Γαβρόβου στη μεταξύ Μεσολογγίου-
Βαράσοβας περιοχή ή όχι.  

 Η υποζώνη Γαβρόβου-Πύλου χαρακτηρίζεται από συνεχή νηριτική ανθρακική 
ιζηματογένεση έως το Ηώκαινο, οπότε παρατηρούνται ασυμφωνίες, με χαρακτηριστική 
ασύμφωνη απόθεση φλύσχη πάνω σε άνω-κρητιδικούς ασβεστολίθους στο βουνό 
Γάβροβο. Σε άλλες θέσεις παρατηρείται ασύμφωνη απόθεση ανω-ηωκαινικών 
ασβεστολίθων πάνω σε παλαιοανάγλυφο με βωξιτικό υλικό , πάνω σε μεσο-ηωκαινικούς 
ασβεστολίθους, όπως στην περιοχή του χωριού Ρίζα της Ανατολικής Κλόκοβας και σε 
πολλές θέσεις της Πύλου. 
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Εικόνα 1.9: Συγκριτική παρουσίση των στρωματογραφικών κολώνων Γαβρόβου και Τριπόλεως, 

Κατσικάτσος Χ, 1992 
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 Η υποζώνη της Τρίπολης χαρακτηρίζεται επίσης από νηριτική ιζηματογένεση με 
ασβεστολίθους και δολομίτες συνεχώς από το Άνω Τριαδικό μέχρι και το Ηώκαινο, με 
χαρακτηριστικούς μαύρους βιτουμενιούχους ασβεστολίθους, γνωστούς σαν Tripolitza kalk 
από τον Philippson(1893). Ο χώρος αυτός δεν απέκτησε ποτέ πελαγική ιζηματογένεση και 
ήταν πάντα μια ρηχή θάλασσα(πλατφόρμα).  

 

Εικόνα 1.10: Στρωματογραφική στήλη της σειράς Γαβρόβου , κατά τον Aubuin, Κατσικάτσος Χ, 1992 

 Η συνολική στρωματογραφική κολώνα της Τρίπολης, είναι απλή λιθολογικά. Αποτελείται 
από μία ακολουθία από νηριτικούς ασβεστολίθους, που αρχίζουν στο Άνω Τριαδικό και 
φτάνουν στο Άνω Ηώκαινο, με μεγάλο πάχος και στην συνέχεια από πάνω έχουμε τον 
φλύσχη, του οποίου η ιζηματογένεση αρχίζει στο Άνω Ηώκαινο. Εκείνο που αλλάζει μέσα 
στην ανθρακική ακολουθία, είναι τα βιοχαρακτηριστικά (απολιθώματα). Έτσι λοιπόν έχουμε 
φύκη Diplopora-Megalodon στο Τριαδικό, κοράλλια Clypeines στο Ιουρασικό, Nerinees 
ρουδιστές στο Κρητιδικό και τέλος νουμουλίτες στο Ηώκαινο. 

Μέσα στους ηωκαινικούς ασβεστολίθους παρατηρείται μια ασυμφωνία, όπου περιέχει 
μικρές εμφανίσεις βωξιτών. Σε μερικές περιοχές το επεισόδειο, που δημιούργησε αυτή τη 
διακοπή της ιζηματογένεσης με χέρσευση, διάβρωση του Ηωκαίνου, που ήδη είχε αποτεθεί, 
αποκομιδή υλικού, δημιουργία βωξίτη και ύστερα επίκλυση με ανω-ηωκαινικούς  
ασβεστολιθους και κατόπιν φλύσχη, διήρκεσε περισσότερο. Έτσι σε πολλές θέσεις έχουμε 
τον φλύσχη απευθείας πάνω στους ασβεστολίθους του Ηωκαίνου ή και του Ανω Κρητιδικού. 
Ενώ στις περιοχές αυτές δεν υπάρχουν βωξίτες, η ανάδυση διήρκησε περισσότερο και η 
φλυσχογένεση αρχίζει σε ένα παλαιοανάγλυφο, ανεπτυγμένο σε ασβεστολίθους, είτε του 
Ηωκαίνου ειτε του Ανω Κρητιδικού. 
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Εικόνα 1.11: Ασύμφωνη απόθεση του φλύσχη Γαβρόβου, πάνω στους δολομιτικούς 

ασβεστολίθους,στην περιοχή της Καταβόθρας Ασπροχωρίου, Παπανικολάου, 2015 

 Στρωματογραφικά ένα ακόμη χαρακτηριστικό της υποζώνης της Τρίπολης είναι η 
διαφορετική βάση της κολώνας-όχι όμως υπόβαθρο- με την εμφάνιση των “στρωμάτων 
Τυρού”. Πρόκειται για ένα ηφαιστειοιζηματογενές σύμπλεγμα, ελαφρά μεταμορφωμένο, που 
περιέχει ανδεσιτικές λάβες, πυροκλαστικά και νηριτικούς ασβεστολίθους και κυριαρχείται 
από πηλίτες και ψαμμίτες. Η ηλικία τους είναι Λιθανθρακοφόρο-Πέρμιο έως και το Μέσο 
Τριαδικό.  

 

 

Συνοψίζοντας οι βασικές διαφορές που εντοπίζονται στις δύο υποζώνες της ενότητας 
Γαβρόβου-Τρίπολης είναι οι εξής: 

 

 

Γάβροβο/Πύλος Τρίπολη 

• Μπροστά από το μέτωπο του καλύμματος της 
Πίνδου 
• Απουσία της βάσης της στρωματογραφικής 
στήλης και τεκτονικού υποβάθρου 
• Κοινή εξέλιξη με την Ιόνια από το Ολιγόκαινο 
• Ήπιος τεκτονισμός και καθόλου μεταμόρφωση 
• Πιθανή συνέχεια της Ιόνιας με πλευρική μετάβαση 

• Πιο εσωτερικός παλαιογεωγραφικός χώρος 
στην ίδια πλατφόρμα 
• Παρουσία των ηφαιστειο‐ιζηματογενών 
στρωμάτων Τυρού στη βάση 
• Ανεξάρτητη ενότητα 
• Έντονη τεκτονική δομή, με λεπιώσεις 
λόγωαποκολλήσεων και με μεταμόρφωση πολύ 
χαμηλού βαθμού στα στρώματα της βάσης της 
• Πιο πίσω στο τόξο, σαν τεκτονικό παράθυρο 
κάτω από την Πίνδο 
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Εικόνα 1.12: Στρωματογραφική απεικόνιση Ενότητα Γαβρόβου-Τριπόλεως, με βάση την 

κωδικοποίηση 
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2. ΜΕΘΟΔΟΛΟΓΙΑ 

 Όπως προαναφέρθηκε, σκοπός της εργασίας αυτής είναι αρχικά η κατανομή των 
γεωλογικών σχηματισμών στις γεωτεκτονικές ενότητες που αντιστοιχεί κάθε μια από τις 
λιθολογίες με βάση την ηλικία, τα απολιθώματα και τα περαιτέρω γεωλογικά χαρακτηριστικά 
τους. Τα φύλλα χαρτών του ΙΓΜΕ έχουν την ιδιαιτερότητα πως δεν έχουν πολλές φορές 
συνοχή με τα γειτονικά τους φύλλα, καθιστώντας έτσι δύσκολη την ανάγνωσή τους από τον 
εκάστοτε μελετητή. Αυτό συνέβαινε διότι οι περιοχές αυτές χαρτογραφήθηκαν σε 
διαφορετικές χρονικές περιόδους και από διαφορετικές ομάδες ατόμων. Καθένας από τους 
συγγραφείς χρησιμοποίησε  διαφορετικούς συμβολισμούς, χρωματικούς συνδυασμούς και 
περιγραφές για καθένα από τους γεωλογικούς σχηματισμούς με αποτέλεσμα κατά την 
τοποθέτηση του ενός χάρτη διπλά στον άλλον να υπάρχει σύγχυση των πληροφοριών και 
των δεδομένων που παρείχαν οι χάρτες. 

Για την σύνταξη της παρούσας εργασίας χρησιμοποιήθηκε το πρόγραμμα ArcGIS desktop 
όπου με αυτό έγινε ψηφιοποίηση κι επεξεργασία των γεωλογικών χαρτών του ΙΓΜΕ. Πιο 
συγκεκριμένα ακολουθηθήκαν τα εξής βήματα: 

1. Μελέτη και ανάλυση των χαρτών του ΙΓΜΕ ώστε να γίνει διευκρίνηση και 
ομαδοποίηση των σχηματισμών των επιμέρους ενοτήτων 

2. Κωδικοποίηση και δημιουργία υπομνήματος για κάθε ενότητα 

3. Ψηφιοποίηση και δημιουργία του χάρτη και του υπομνήματος με την χρήση του 
GIS 

 

2.1 Μελέτη και ανάλυση των χαρτών του ΙΓΜΕ  

 Αφού έγινε η μελέτη των χαρτών, με την βοήθεια των υπομνημάτων, και η ταξινόμηση με 
βάση το ποιες από τις γεωτεκτονικές ενότητες, οι οποίες αφορούσαν  την παρούσα εργασία 
αναφέρονταν σε καθένα από τα φύλλα χαρτών πχ. Ενότητα Πίνδου στα φύλλα ΙΓΜΕ με 
κωδικό:154, 142, 142 κοκ. Αφού σχηματίστηκαν και οι στρωματογραφικές στήλες-κολώνες 
των ενοτήτων αυτών, πραγματοποιήθηκε και η ομαδοποίηση των σχηματισμών. 

Η ταξινόμηση και η ομαδοποίηση των σχηματισμών κρίθηκε αναγκαία καθώς καθένας από 
τους σχηματισμούς του Ελλαδικού χώρου, μπορεί να είναι ίδιος με έναν άλλον ως προς την 
ορυκτολογία-πετρολογία (π.χ. Ασβεστόλιθοι), με διαφορετικά όμως χαρακτηριστικά. Για 
αυτό τον λόγο αποφασίστηκε να διαχωριστεί-κωδικοποιηθεί καθένας από τους 
σχηματισμούς ανάλογα με τα επιμέρους χαρακτηριστικά τους. Ο διαχωρισμός των 
σχηματισμών έγινε με βάση την ενότητα στην οποία ανήκουν, την ηλικία και τα απολιθώματα 
που περιέχουν. Έπειτα ομαδοποιήθηκαν κάποια πακέτα σχηματισμών ανάλογα με τις 
γεωλογικές περιόδους και το τι συνέβη τότε και τέλος για καθένα από τον σχηματισμό 
δόθηκε ένας τριψήφιος κωδικός. Η διαδικασία της κωδικοποίησης πραγματοποιήθηκε για 
την δημιουργία ενός νέου υπομνήματος που οδηγεί στην πιο γρήγορη ανάγνωση του νέου 
αυτού χάρτη αλλά και στην αναγνώριση του εκάστοτε σχηματισμού κατά την εργασία στον 
υπολογιστή. 
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Εικόνα 2.1: Διάγραμμα των 327 φύλλων της σειράς του «Βασικού Γεωλογικού Χάρτη της Ελλάδας σε 

κλίμακα 1:50.000»,που έχει εκδώσει το ΙΓΜΕ και καλύπτει το σύνολο του ελληνικού χώρου 
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2.2 Κωδικοποίηση 

Η κωδικοποίηση βασίστηκε στους παρακάτω παράγοντες, καθένας από τους οποίους 
αντιπροσωπεύει το αντίστοιχο ψηφίο του κωδικού: 

1. Το πρώτο ψηφίο, ορίζει την Γεωτεκτονική ενότητα στην οποία ανήκει ο γεωλογικός 
σχηματισμός 

2. Το δεύτερο ψηφίο, τον γεωλογικό σχηματισμό-πακέτο σχηματισμών   

3. και το τρίτο ψηφίο, αποτελεί υποδιαίρεση εντός του σχηματισμού 

Για παράδειγμα η ενότητα των Παξών έχει τον αριθμό 1 και ο φλύσχης της τον αριθμό 1. 
Εφόσον όμως δεν έχουμε καμία υποδιαίρεση του σχηματισμού-άρα το τρίτο ψηφίο είναι το 
0-, τότε ο κωδικός διαμορφώνεται ως “110”. 

Στην ενότητα της Τρίπολης έχουμε ασβεστολίθους που βρίσκονται όμως εντός του φλύσχη 
Επειδή αποτελούν υποδιαίρεση του, το τρίτο ψηφίο αλλάζει και ο κωδικός διαμορφώνεται 
σε “511”,”512” κοκ ανάλογα το πλήθος των υποδιαιρέσεών του. 

 

2.3 Διαδικασία ψηφιοποίησης και επεξεργασίας χαρτών στο ArcGIS 

Όσον αφορά την πρόοδο και την ολοκλήρωση της εργασίας με το GIS ακολουθήθηκαν τα 
εξής βήματα: 

2.3.1 Εισαγωγή και γεωαναφορά φύλλου χάρτη 

Αρχικά έγινε εισαγωγή του φύλλου που επρόκειτο να ψηφιοποιηθεί  στο πρόγραμμα και η 

γεωαναφορά του. Έτσι αφού ανοίγουμε το ArcMap   και ακολουθούμε τα εξής βήματα: 

i. Στην κεντρική καρτέλα των Windows, έγινε εκκίνηση του προγράμματος 

“ArcCatalog” . 

ii. Έπειτα στο αναδυόμενο παράθυρο, επιλέχθηκε η εντολή με το εικονίδιο 
“Connect to folder” και στην συνέχεια ο φάκελος που είναι αποθηκευμένοι οι 
χάρτες.  

iii. Στην λίστα του Catalog, βρίσκεται πλέον ο φάκελος που «συνδέθηκε». 
Επιλέγοντας τον και στην συνέχεια εντοπίζοντας το αρχείο που θα 
ψηφιοποιηθεί, με δεξί κλικ επιλέχθηκε η εντολή Properties 

iv. Στον πίνακα που εμφανίστηκε, επιλέχθηκε στο Spatial reference το Εdit”. Το 
προβολικό σύστημα που χρησιμοποιήθηκε είναι το Greek Grid. 

v. Στην καρτέλα που ανοίγει ακουλούθησαν τα παρακάτω βήματα: 
Select→Projected Coordinate Systems→National Grids→Europe, 
επιλέγουμε το Greek grid και πατάμε ΟΚ. 

vi. Στην καρτέλα Properties, επιλέχθηκε το  Build στο Pyramids. Αν δεν θέλουμε 
να αλλάξει το Path που θα αποθηκευτεί ο χάρτης, στο παράθυρο διαλόγου 
που ανοίγει, κάνουμε κλικ στο ΟΚ. Στο Properties, για κλείσει η καρτέλα, 
κάνουμε ξανά κλικ στο ΟΚ. 

vii. Ο χάρτης πλέον έχει εμφανιστεί στο ArcMap. Στην καρτέλα 
Customize→Toolbars επιλέγοντας το “Georeferencing”, εμφανίστηκε μία 
καινούρια εργαλειοθήκη.  Στο “Layer”, επιλέξαμε τον χάρτη με τον οποίο 
εργαστήκαμε. 

viii. Στην ίδια εργαλειοθήκη επιλέγουμε “Add Control Points”. Παρατηρούμε πως 
ο δείκτης του ποντικιού, γίνεται σταυρόνημα. Γεωναφέρονται τουλάχιστον 3 
σημεία του χάρτη με συντεταγμένε, όπου επιλέγονται με διπλό κλικ με το 
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σταυρόνημα. Έπειτα στο toolbar του Georeferencing, στο εικονίδιο του View 
Link Table βάζουμε τις συντεταγμένες(X,Y) με βάση το φύλλο του χάρτη . Αν 
είναι σε Greek Grid, κάνουμε εισαγωγή απευθείας. Αν όμως είναι σε μοίρες, 
μετατρέπουμε πρώτα σε Greek Grid και κάνουμε εισαγωγή των 
συντεταγμένων.  

 

Εικόνα 2.2: Στιγμιότυπα οθόνης όπου φαίνεται η διαδικασία επιλογής προβολικού συστήματος 

 

 

Εικόνα 2.3: Builds pyramids για την γεωαναφορά του χάρτη 
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Εικόνα 2.4: Τοποθέτηση του σταυρονήματος (βλέπε πάνω αριστερή γωνία), για την γεωαναφορά του 

χάρτη 

2.3.2 Δημιουργία Shapefile 

Αφού ολοκληρώθηκε η γεωαναφορά, πηγαίνοντας ξανά στον ArcCatalog, για την 
δημιουργία ενός νέου Shapefile, ακολουθήθηκαν τα παρακάτω βήματα: 

i. File→New→Shapefile. Στο feature type κλικ στην  εντολή Polygon και στις 
συντεταγμένες επιλέχθηκε και πάλι το Greek Grid. Έπειτα δόθηκε η κατάλληλη 
τιτλοδοσία και τέλος κλικ στο ΟΚ. 

ii. Μέσα στον Catalog, επιλέγοντας το αρχείο που δημιουργήθηκε, δεξί κλικ στο 
Properties. Στο παράθυρο που ανοίγει, με δεξί κλικ επιλογή της καρτέλας 
Fields, δημιουργήθηκαν ένα προς ένα τα αντίστοιχα πεδία που χρειάστηκαν, 
επιλέγοντας τον αντίστοιχο τύπο περιεχομένων πληροφοριών (π.χ. coding – 
short integer). πατάμε ΟΚ. 
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2.3.3 Σχεδιασμός πολυγώνων 

Αφού έγινε η εισαγωγή του Shapefile που δημιουργήθηκε στο ArcMap desktop - δεξί κλικ 

στο Layers →Add data , επιλογή του Shapefile  - ξεκινήσε η δημιουργία πολυγώνων. 

i. Ανοίγοντας την εργαλειοθήκη του Editor (Customize→Toolbars→Editor), 
επιλέχθηκε η εντολή “Start editing” 

ii. Έπειτα από το Editor→Editing windows→Create features 

iii. Στο παράθυρο που άνοιξε επιλέχθηκε το Shapefile . Στην συνέχεια στο 
Construction tools , κλικ στο Polygon και ξεκίνησε ο σχηματισμός του πρώτου 
πολυγώνου. 

iv. Έπειτα αλλάζοντας εργαλείο από την εργαλειοθήκη του Editor, έγινε επιλογή του 
Cut polygons tool και ξεκίνησε η διαδικασία δημιουργία-σχεδιασμού 
πολυγώνων, με οδηγό τον χάρτη που γεωαναφέρθηκε προηγουμένως 

v. Για κάθε πολύγωνο, πηγαίνοντας στην εργαλειοθήκη του Editor, επιλέχθηκε το 

άνοιγμα του παραθύρου Attributes . Εκεί συμπληρώθηκαν τα κατάλληλα 
στοιχεία-πληροφορίες στα αντίστοιχα πεδία για κάθε πολύγωνο(πχ. το coding,  
geo_zone, lithology, igme_code)  

vi. Η διαδικασία συνεχίστηκε μέχρις ότου  να ολοκληρωθεί ολόκληρος ο χάρτης. 

vii. Τέλος κλικ στον Editor→Save edits, για την αποθήκευση των πολυγώνων και 
οποιασδήποτε επεξεργασίας-αλλαγής αυτών. 

 

Εικόνα 2.5: Σχεδιασμός πολυγώνων με το εργαλείο “Cut polygon tools” 
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2.3.4 Coding 

Όταν ο χάρτης και τα πεδία του Attribute table είναι έτοιμα, ξεκινά η δημιουργία του 
συμβολισμού για τον κάθε γεωλογικό σχηματισμό: 

i. Στις καρτέλες, πήγαμε στο Customize→Style manager 

ii. Στο παράθυρο που άνοιξε επιλέχθηκε το Styles και στο επόμενο παράθυρο 
που ανοίγει “Create new style”. Το “Style”, ονομάστηκε σύμφωνα με την 
ενότητα που απευθύνεται η ομάδα των σχημάτων που δημιουργήσαμε (π.χ. 
Paxoi για την ενότητα της Παξών), πατάμε Save και OK 

iii. Στο παράθυρο του Style manager στην αριστερή στήλη επιλέχθηκε το Style 
που δημιουργήθηκε και έπειτα στην δεξιά στήλη, δεξί κλικ στο Fill 
symbols→New→Fill symbol. 

iv. Στην συνέχεια, με βάση τα στοιχεία από την ιστοσελίδα της Inspire knowledge 
base[4], δημιουργήθηκε ο συμβολισμός για καθένα από τους γεωλογικους 
σχηματισμούς. Το χρώμα του εκάστοτε συμβολισμού αντιπροσωπεύει την 
ηλικία του σχηματισμού που ψηφιοποιήσαμε, ενώ το μοτίβο του, την λιθολογία 
του. Επιλέχθηκε σαν τύπος συμβολισμού “Picture Fill Symbol” και στην 
συνέχεια στην εντολή Picture, έγινε επιλογή του μοτίβου. 

v. Ο κάθε σχηματισμός, ονομάστηκε με βάση το coding των γεωλογικών 
σχηματισμών που θα είχαν αυτόν τον συμβολισμό (όπως περιγράφεται στο 
κεφάλαιο 1.2 Περιγραφή γεωτεκτονικών ενοτήτων για κάθε ενότητα). 

 

 

Εικόνα 2.6:Δημιουργία Style για καθεμία από τις ενότητες 

file:///C:/Users/Chris/Downloads/ΠΕΡΓΑΜΟΣ-ΕΦΗ%20(2).doc%23_ΑΝΑΦΟΡΕΣ
file:///C:/Users/Chris/Downloads/ΠΕΡΓΑΜΟΣ-ΕΦΗ%20(2).doc%23_Περιγραφή_γεωτεκτονικών_ενοτήτων
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Εικόνα 2.7: Σχεδιασμός συμβολισμών για καθένα από τους γεωλογικούς σχηματισμούς του χάρτη 

 

2.3.5 Ενοποίηση σχηματισμών με βάση το Coding 

Αφού ολοκληρώθηκε ο σχηματισμός των πολυγώνων και η κωδικοποίηση που τους 
αντιστοιχεί σε καθέναν από αυτούς, το επόμενο βήμα ήταν η ενοποίηση τους ως προς το 
coding. Για να γίνει αυτό χρησιμοποιήθηκε το εργαλείο “Dissolve” ακολουθώντας τα εξής 
βήματα:  

i. Geoprocessing→Dissolve. Στον πίνακα που ανοίγει, στο Input features 
επιλέχθηκε το Shapefile που κατασκευάστηκε παραπάνω και στο Output class 
features, το μέρος όπου θα γινόταν η αποθήκευση. Στο Dissolve Field 
επιλέγοντας το πεδίο που θέλουμε να ενοποιήσουμε και συγκεκριμένα το 
“Coding”, δημιουργείται ένας νέος χάρτης με ενοποιημένους τους 
σχηματισμούς σύμφωνα με το Coding.  

ii. Έπειτα πηγαίνοντας ξανά στο Arc Catalog και με την διαδικασία που 
αναφέρθηκε παραπάνω, δημιουργήθηκαν και τα υπόλοιπα πεδία που είναι 
απαραίτητα για την ανάγνωση του χάρτη και την δημιουργία υπομνήματος 
(Lithology, Age) 

iii. Επιστρέφοντας στο παράθυρο του ArcMap desktop και με δεξί κλικ στο 
Shapefile στην αριστερή στήλη, έγινε άνοιγμα του Attribute table 

iv. Ταυτόχρονα ενεργοποιήθηκε ξανά ο Editor ώστε να επεξεργαστούν τα πεδία 
που δημιουργήθηκαν στον Catalog, συμπληρώνοντας στα αντίστοιχα πεδία 
την γεωτεκτονική ενότητα, τα ονόματα και τις ηλικίες των σχηματισμών. 

v. Στο Table of contents, δεξί κλικ στο Layer και Properties. Έπειτα στην καρτέλα 
Symbology→Categories→Unique values, many fields και επιλογή του Coding 
και του Lithology. Κάθε σχηματισμός χρωματίστηκε βάσει του Coding όπως 
εξηγήσαμε παραπάνω. 
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Εικόνα 2.8: Συγχώνευση των σχηματισμών ίδιου γεωλογικού-λιθολογικού τύπου 

 

Εικόνα 2.9: Δημιουργία του νέου πεδίου στον Attribute table, με όνομα Coding 
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2.3.6 Δημιουργία χάρτη - Υπόμνημα 

Ο χάρτης, σε ηλεκτρονική μορφή πλέον, είναι έτοιμος. Χρειάστηκε όμως και η έντυπη 
μορφή. Βασικά στοιχεία ενός χάρτη είναι το υπόμνημα, η κλίμακα, ο προσανατολισμός και 
το πλέγμα των συντεταγμένων. Επομένως: 

i. Έπειτα στην καρτέλα View ,έγινε επιλογή του Layout. 

ii. Για να είναι πιο ευανάγνωστο το υπόμνημα στον πίνακα που είμαστε από το 
προηγούμενο βήμα ομαδοποιούμε τους σχηματισμούς ανά ενότητα. 
Επιλέγουμε τους σχηματισμούς που αντιστοιχούν στην εκάστοτε ενότητα και 
μετά δεξί κλικ →Move to heading→New heading→Γράφουμε το όνομα της 
ενότητας→Ok 

iii. Στην συνέχεια εισάγουμε το υπόμνημα από την καρτέλα Insert →Legend και 
στις αναδυόμενες καρτέλες μορφοποιούμε το υπόμνημά  

iv. Έπειτα για το σύμβολο του Βορά στην καρτέλα Insert →North arrow  

v. Τέλος για το πλέγμα των συντεταγμένων πατάμε δεξί κλικ πάνω στον χάρτη 
μας →Properties →Grids →New Grid. Διαλέγοντας τη 2η επιλογή “Measured 
Grid” και στην συνέχεια Next στις καρτέλες, επιλέγοντας πως θα είναι το 
πλέγμα. Τέλος Finish →Ok. 

 

Εικόνα 2.10: Κατασκευή πλέγματος συντεταγμένων 

 

2.3.7 Αποθήκευση αρχείου-χάρτη 

Ο χάρτης μας είναι έτοιμος. Πλέον μπορούμε να τον εκτυπώσουμε μέσω του File →Print  ή 
να τον  αποθηκεύσουμε σαν αρχείο εικόνας ακολουθώντας τα βήματα File→ Export map 
όπου επιλέγουμε ανάλυση, format και την θέση που θέλουμε να αποθηκευτεί και Save για 
αποθήκευση. 
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2.3.8 Τελικοί γεωλογικοί χάρτες Ενοτήτων και σχηματισμών 

Στο επόμενο κεφάλαιο, 3.ΧΑΡΤΕΣ, ακολουθεί η αποτύπωση των «νέων» χαρτών για κάθε 

μια ενότητα ξεχωριστά. Και στο κεφάλαιο 4.ΠΙΝΑΚΕΣ, περιγράφεται η κατανομή της 

κωδικοποίησης, για καθένα  πακέτο σχηματισμών, ανά ηλικία και δίπλα ο συμβολισμός τους, 

όπως ακριβώς έχουν αποτυπωθεί στο παρόν κεφάλαιο, στους χάρτες. 
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3. ΧΑΡΤΕΣ 

[ΒΑ1] 

Εικόνα 3.1: Χωρική Κατανομή γεωλογικών σχηματισμών της Ενότητας Παξών, Ιονίας, Γαβρόβου-

Τριπόλεως, Μάνης και Άρνας 
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Εικόνα 3.2: Κατανομή γεωλογικών σχηματισμών της Ενότητας Παξών 
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Εικόνα 3.3: Κατανομή γεωλογικών σχηματισμών της Ιόνιας Ενότητας 
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Εικόνα 3.4: Κατανομή γεωλογικών σχηματισμών της Ενότητας Μάνης 
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Εικόνα 3.5: Κατανομή γεωλογικών σχηματισμών της Ενότητας Άρνας 
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Εικόνα 3.6: Κατανομή γεωλογικών σχηματισμών της Ενότητας Γαβρόβου-Τρίπολης 
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4. ΠΙΝΑΚΕΣ 

4.1 Πίνακες ενοτήτων συναρτήσει κωδικοποιήσης: 

  

 Πίνακας 1: Ενότητα Παξών  

Κωδικός Περιγραφή Σχηματισμού Ηλικία Συμβολισμός 

110 Αργιλικοί και μαργαϊκοί 
σχηματισμοί, τουρβιδιτικοί 

ασβεστόλιθοι 

Μειόκαινο - Ολιγόκαινο 

 

120 Ασβεστόλιθοι, Σχιστόλιθοι και 
Δολομίτες 

Μέσο Ιουρασικο - 
Ηώκαινο 

 

130 Γύψοι-εβαπορίτες Μεσσήνιο 

 

 

 

 Πίνακας 2: Ιόνια ενότητα 

Κωδικός Περιγραφή Σχηματισμού Ηλικία Συμβολισμός 

210 Φλύσχης Ιόνιας Ολιγόκαινο – Ηώκαινο 

 

220 Ασβεστόλιθοι με Nummulites και 
ασβεστόλιθοι με Ρουδιστές 

Ηώκαινο-Αν.Κρητιδικό 

 

230 Ασβεστόλιθοι φάσης “Βίγλα”, 
Σχιστόλιθοι με Posidonies και 
ασβεστόλιθοι με Ammonitico 

Rosso 

Μέσο Κρητιδικό – Κατω 
Ιουρασικό(Αν.Λιάσιο) 

 

240 Ασβεστόλιθοι “Παντοκράτορα”, 
Ασβεστόλιθοι Φουσταπήδημα με 

Cardita και Δολομίτες 

Τριαδικό – Κατω Ιουρασικό 

 

250 Εβαπορίτες Τριαδικό(Κάρνιο) 
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Πίνακας 3: Ενότητα Μάνης 

Κωδικός Περιγραφή Σχηματισμού Ηλικία Συμβολισμός 

310 Φλύσχης Μάνης (ελαφρά 
μεταμορφωμένος) 

Ολιγόκαινο 

 

320 Πολύχρωμα Σιπολινομάρμαρα, 
Κλαστικοί κρυσταλλικοί 

ασβεστόλιθοι 

Ηώκαινο 

 

330 Plattenkalk (Βίγλα), Πυριτικοί 
κρυσταλλικοί ασβεστόλιθοι και 

Σχιστόλιθοι 

Δογγέριο-Ανω Σενώνιο 

 

340 Συμπαγή λευκά μάρμαρα 
(Παντοκράτορα) 

Μέσο Τριαδικό-Λιάσιο 

 

350 Φυλλίτες Καστανιάς Πέρμιο-Κάτω Τριαδικό 

 

360 Εμφάνιση ενότητας της Μάνης 
στην περιοχή του Πάρνωνα 

Μεσοζωικό 
 

 

 

 Πίνακας 4: Ενότητα Άρνας 

 

  

Κωδικός Περιγραφή Σχηματισμού Ηλικία Συμβολισμός 

400 Φυλλίτες-Χαλαζίτες Παλαιοζωικό 
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Πίνακας 5: Γαβρόβου-Τρίπολης 

Κωδικός Περιγραφή Σχηματισμού Ηλικία Συμβολισμός 

510 Φλύσχης Γαβρόβου-Τρίπολης Ολιγόκαινο 

 

511 Ηφαιστειακά (Ανδεσίτες) μέσα 
στο φλύσχη 

- 

 

512 Τεμάχη ασβεστολίθων μέσα στο 
φλύσχη 

Ποικίλης ηλικίας 

 

520 Ασβεστόλιθοι Άνω Τριαδικό – Άνω 
Ηώκαινο 

 

530 Στρώματα Τυρού Πέρμιο – Τριαδικό 

 

531 Μάρμαρα μέσα στα στρώματα 
Τυρού 

Λιθανθρακοφόρο – Πέρμιο 

 

540 Εμφάνιση Βωξίτη Ηώκαινο – Παλαιόκαινο 
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4.2 Φύλλα χαρτών Ι.Γ.Μ.Ε. , που χρησιμοποιήθηκαν στην παρούσα εργασία: 

 

Πίνακας 6: ΧΑΡΤΕΣ - ΦΥΛΛΑ Ι.Γ.Μ.Ε. 

No 81: ΠΑΓΩΝΙΑΝΗ - ΒΑΣΙΛΙΚΟ 

No 82: ΚΟΝΙΤΣΑ 

No 83: ΠΕΝΤΑΛΟΦΟΣ, J. BRUNN, 1960 

Νο 91: ΔΕΛΒΕΝΑΚΙ 

No 93: ΤΣΕΠΕΛΟΒΟ 

No 94: ΜΕΤΣΟΒΟ, J. BRUNN, 1952  

No 104: ΚΕΡΚΥΡΑ ΒΟΡΕΙΑ,E. SAVOYAT, Δ. ΜΟΝΟΠΟΛΗ, 1962 

Νο 105: ΣΑΓΙΑΔΑ 

No 106: ΦΙΛΙΑΤΕΣ, R.PERRIER, Κ.ΚΟΥΚΟΥΖΑΣ 

No 107: ΚΛΗΜΑΤΙΑ, R.PERRIER, Κ.ΚΟΥΚΟΥΖΑΣ 

No 108: ΙΩΑΝΝΙΝΑ, E. SAVOYAT, L.POTIER, E. SAVOYAT, 1962 

No 109: ΠΡΑΜΑΝΤΑ, J, AUBUIN, 1957 

Νο 118: ΚΕΡΚΥΡΑ ΝΟΤΙΑ, E. SAVOYAT, Δ. ΜΟΝΟΠΟΛΗ, 1962 

Νο 119: ΠΑΡΓΑ, R.PERRIER, Κ.ΚΟΥΚΟΥΖΑΣ,1962 

Νο 120: ΠΑΡΑΜΥΘΙΑ, R.PERRIER, Γ.ΚΑΤΣΙΚΑΤΣΟΣ, Ν. ΛΑΛΕΧΟΥ, Ν. ΦΙΛΙΠΠΑΚΗ,1962 

Νο 121:ΘΕΣΠΡΩΤΙΚΟΝ, E. SAVOYAT, Δ. ΜΟΝΟΠΩΛΗ, Γ.ΚΑΤΣΙΚΑΤΣΟΣ, Ν. ΛΑΛΕΧΟΥ, Ν. ΦΙΛΙΠΠΑΚΗ 

No 122: ΑΓΝΑΝΤΑ, E. SAVOYAT, Δ. ΜΟΝΟΠΟΛΗ, Ν. ΛΑΛΕΧΟΥ, Ν. ΦΙΛΙΠΠΑΚΗ 

No 123: ΜΥΡΟΦΥΛΛΟ, Κ. ΜΑΝΑΚΟ 

Νο 134: ΝΗΣΟΙ ΠΑΞΟΙ 

Νο 135: ΚΑΝΑΛΑΚΙΟΝ, J.J BIZON, P.DOURTHE, M.LATREILLE, R.PERRIER, J.ROCHET, E.SAVOYAT, 
Γ.ΚΑΤΣΙΚΑΤΣΟΣ, 1967 

Νο 136: ΑΡΤΑ, M.LATREILLE, E.SAVOYAT, Δ.ΜΟΝΟΠΩΛΗ, 1969 

Νο 137:ΠΕΤΑ, E. SAVOYAT, Δ. ΜΟΝΟΠΩΛΗ, 1966 

No 138: ΡΑΠΤΟΠΟΥΛΟ, E. SAVOYAT, Δ. ΜΟΝΟΠΩΛΗ, Ν. ΛΑΛΕΧΟΥ, Ν. ΦΙΛΙΠΠΑΚΗ, 1970 

No 139: ΑΓΡΑΦΑ, Ν. ΛΥΜΠΕΡΗ, P. CHOTIN, Κ. ΜΠΟΝΤΟΖΗ, 1977 

Νο 152: ΒΟΝΙΤΣΑ, Κ.ΜΑΝΑΚΟΣ, 1993 

Νο 153: ΑΜΦΙΛΟΧΙΑ, Ν.ΚΑΤΣΙΑΒΡΑΣ, 1984 

Νο 154: ΑΛΕΥΡΑΔΑ 

No 155: ΦΡΑΓΚΙΣΤΑ, J.J.FLEURY, J.P.CHARRE, 1980 

Νο 164: ΛΕΥΚΑΔΑ, Ι.ΜΠΟΡΝΟΒΑΣ, 1963 

Νο 165: ΚΑΛΑΜΟΣ, Κ.ΜΑΝΑΚΟΣ, 1985 

Νο 166: ΑΣΤΑΚΟΣ 

Νο 167: ΑΓΡΙΝΙΟ 

No 168: ΘΕΡΜΟΝ, D. L. LOFTUS, Ν.ΦΙΛΙΠΠΑΚΗ, ΑΝ. ΜΑΥΡΙΔΗ, 1977 

Νο 181: ΚΕΦΑΛΛΟΝΙΑ ΒΟΡΕΙΑ, H.BERGMANN, K.BRAUNE, G.DREMEL, ΧΑΤΖΟΠΟΥΛΟΣ, F.HUG, 
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5. ΣΥΜΠΕΡΑΣΜΑΤΑ 

Η εργασία αυτή ολοκληρώθηκε στα πλαίσια βιβλιογραφικής έρευνας για την γεωλογία του 
Ελλαδικού χώρου και στην συνέχεια, ο χάρτης που δημιουργήθηκε ήταν αποτέλεσμα πολύ 
χρόνου με καταγραφή των χαρακτηριστικών για κάθε σχηματισμό ξεχωριστά. Ο χάρτης μας, 
διακρίνει τις γεωτεκτονικές ζώνες με τους σχηματισμούς τους και βασίζεται στην 
κωδικοποίηση που δημιουργήσαμε για αυτούς. 

Τα διαφορετικά χρώματα και τα σχήματα κάθε σχηματισμού που τα διακρίνει είναι το κύριο 
χαρακτηριστικό της διαδικασίας της κωδικοποίησης. Τέλος δημιουργήθηκε μια νέα βάση 
δεδομένων, όσο το δυνατόν λεπτομερέστερη, για τον εμπλουτισμό του υπομνήματος. 

  



Ψηφιοποίηση και ενοποίηση γεωλογικών σχηματισμών ενοτήτων Παξών, Ιόνιας, Γαβρόβου-Τριπόλεως, Μάνης και Άρνας 

Ευθυμία Καλαματιανού-Δημητροπούλου   53 

ΠΙΝΑΚΑΣ ΟΡΟΛΟΓΙΑΣ 

Ξενόγλωσσος όρος Ελληνικός Όρος 

Terrain Τεκτονοστρωματογραφικό πεδίο  

Greek Grid ΕΓΣΑ’ 87 
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ΣΥΝΤΜΗΣΕΙΣ – ΑΡΚΤΙΚΟΛΕΞΑ – ΑΚΡΩΝΥΜΙΑ 

GIS Geographic Information Systems 

ΙΓΜΕ Ινστιτούτο Γεωλογικών και Μεταλλευτικών Ερευνών 

ΕΚΠΑ  Εθνικό και Καποδιστριακό Πανεπιστήμιο Αθηνών  

USGS United States Geological Survey 

ΕΓΣΑ’87 Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς 

GGRS’87 Greek Geodetic Reference System 
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